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Distiller Job Options
DistillerNotes.ps V1.01E  1998 PrePress-Consulting, Switzerland & Lupin Software, USA
Latest version: http://www.prepress.ch, Info: sjaeggi@prepress.ch / info@lupinsw.com
====================================================================
This note should be viewed with Helvetica and a point size of 10 points.
You can print this information using Tools>Summarize Notes and File>Print... 

!!! THE SHAREWARE FEE FOR DISTILLERTOOLS HAS NOT BEEN PAID YET !!!

__/ GENERAL\________________________________________________________
FILE SETTINGS
    Compatibility = Acrobat 3.0
    ASCII Format = Off
DEVICE SETTINGS
    Current Resolution = 600.0 x 600.0 dpi
    Current Page Size = 612 x 792 points / 8.5 x 11.0 inch / 21.59 x 27.94 cm
    (The above settings are the actual values in use, NOT the entries in Distiller options!)

__/ COMPRESSION \___________________________________________________
    Compress Text and Line Art = On
COLOR BITMAP IMAGES
    Sampling = Average to 72 dpi
    Automatic Compression: ZIP/JPEG Medium
GRAYSCALE BITMAP IMAGES
    Sampling = Average to 72 dpi
    Automatic Compression: ZIP/JPEG Medium
MONOCHROME BITMAP IMAGES
    Sampling = Average to 300 dpi
    Manual Compression: CCITT Group 4

__/ FONT EMBEDDING \________________________________________________
    Embed All Fonts = Off
    Subset Fonts = On below 35 %
    Always Embed List: 
    Never Embed List: 

__/ ADVANCED \______________________________________________________
    prologue.ps / epilogue.ps = Not Used
    Convert CMYK Images to RGB = On
    Preserve OPI Comments = Off
    Preserve Overprint settings = Off
    Preserve Halftone Screen Information = Off
    Transfer Functions = Apply
    Undercover Removal / Black Generation = Remove
    Color Conversion = Unchanged
____________________________________________________________________
ADDITIONAL INFORMATION
    Distiller Version = 3.0 / Windows
    ImageMemory = 524288
    AutoRotatePages = PageByPage
    UseFlateCompression = On
    ConvertImagesToIndexed = On
    ColorImageDepth = Unchanged
    AntiAliasColorImages = On
    GrayImageDepth = Unchanged
    AntiAliasGrayImages = On
    MonoImageDepth = Unchanged
    AntiAliasMonoImages = On
____________________________________________________________________

SHAREWARE NOTICE

DistillerTools 1.0 are distributed as SHAREWARE over the Internet because we would like to allow as many Acrobat users as possible to try out our tools.

We have put several hundred hours in the development of this software. (It was not as easy as we thought it would be!)

That's why we decided to limit the functionality of this demo version a little bit. On average, every fifth report of DistillerNotes, FontNotes and MakePrologue will be suppressed randomly. So be careful when using the tools. You never know when "Mister Random" will catch you...<g>

If you would like to use DistillerTools on a regular basis you should pay one of the following shareware fees:
   - single license         = US$   49.00 / CHF   69.--
   - site license             = US$ 199.00 / CHF 280.--
   - world-wide license* = US$ 299.00 / CHF 420.--
* A world-wide license will allow you to give DistillerTools (or a part of them) to your customers.

You can pay on-line using almost any credit card through the Kagi Shareware Registration Service at: http://order.kagi.com/?QMX

Or you can use the Order application (not available on Unix) to create an order which you can send via e-mail, fax or mail to Kagi together with a check or cash (please consult Reame.pdf for more information). In Europe you can also fill out and print the form Order.pdf and send a check or money order to PrePress-Consulting, Bottmingerstrasse 92, CH-4102 Binningen, Switzerland. Our postal account in Switzerland is PC 40-49772-1. Paying us in Switzerland however can take 2 to 3 weeks. The fastest way to get your registration key is to deal with Kagi.

When we have received your shareware fee we will send you instructions to install the registration key. When this key is loaded, the limitations of the demo version will be deactivated. Therefore, do not forget to tell us your correct e-mail address. This will be the fastest way to send you the instructions.

If we get enough feedback (in the form of checks!) we will create a new series of tools (we already have a lot of interesting ideas).

Thank you very much for your support!


DISTRIBUTION

We give you the right to distribute the demo version (without the registration key) 
to your friends and customers on an individual basis. If you want to distribute 
our tools on a CD-ROM or put them on your web site or BBS, please contact us first.


CUSTOMIZED VERSIONS

For a small fee you can get customized versions of DistillerTools with your own text in the 
notes and reports (e.g. special instructions for your customers) and your messages in 
the Distiller window. A great marketing tool! Contact us for a quote.


Fonts used in this document
FontNotes V1.01  1998 Lupin Software, USA & PrePress-Consulting, Switzerland
Latest version: http://www.prepress.ch, Info: info@lupinsw.com / sjaeggi@prepress.ch
====================================================================
This note should be viewed with Helvetica and a point size of 10 points.
You can print this information using Tools>Summarize Notes and File>Print... 

!!! THE SHAREWARE FEE FOR DISTILLERTOOLS HAS NOT BEEN PAID YET !!!

The following fonts were AVAILABLE during distilling: 
    Courier       (Core Font ***)
    Gen_85-Helvetica-Heavy       (PostScript Font - Type 1)
    Helvetica-BoldOblique       (Core Font ***)
    Helvetica-Narrow-Bold       (artifical font)
    Helvetica-Bold       (Core Font ***)
    Times-Bold       (Core Font ***)
    MSTT31311d5689o117048S00       (PostScript Font - Type 1)
    Helvetica       (Core Font ***)
    Times-Roman       (Core Font ***)
    MSTT3144b1107ao122041S00       (PostScript Font - Type 1)
    AdobeSansMM       (Substitution Font)

*** Attention: Core Fonts are never embedded!


__/ DISTILLER FONT SETTINGS \________________________________________
    Embed All Fonts = Off
    Subset Fonts = On below 35 %
    Always Embed List: 
    Never Embed List: 
____________________________________________________________________
!!! The font  database "Distsadb.dos" was present in the Data directory.
!!! To avoid font substitution you should remove this file

Sometimes applications are calling certain fonts (e.g. Courier, Symbol)
by default even if they might not be used in the document!
____________________________________________________________________

DISCLAIMER

NO software is free of all errors. We have extensively tested DistillerTools and have 
made every attempt to make our tools compatible with all platforms supported by 
Acrobat Distiller. Because our PostScript programs are loaded at the time Distiller 
starts up, we have to work on top of your PostScript programs which are generated by 
a wide variety of applications and printer drivers from different platforms. If you 
encounter an error after you have loaded our tools, do not panic! Just remove the tool 
from the startup directory and restart Distiller. You will be fine. If errors occur please 
go to our bug report page at http://www.prepress.ch/e/pdf/distillertools/bug-report.html 
and report your problem using the form on our website.  DO NOT SEND HUGE 
POSTSCRIPT FILES, just send us the log file created by Distiller! We will 
contact you if we need the PS file to fix the error. We hope that you understand 
that we can not provide any phone support for these tools. Thank you very much for 
your cooperation!

SHAREWARE NOTICE

DistillerTools 1.0 are distributed as SHAREWARE over the Internet because we would like to allow as many Acrobat users as possible to try out our tools.

We have put several hundred hours in the development of this software. (It was not as easy as we thought it would be!)

That's why we decided to limit the functionality of this demo version a little bit. On average, every fifth report of DistillerNotes, FontNotes and MakePrologue will be suppressed randomly. So be careful when using the tools. You never know when "Mister Random" will catch you...<g>

If you would like to use DistillerTools on a regular basis you should pay one of the following shareware fees:
   - single license         = US$   49.00 / CHF   69.--
   - site license             = US$ 199.00 / CHF 280.--
   - world-wide license* = US$ 299.00 / CHF 420.--
* A world-wide license will allow you to give DistillerTools (or a part of them) to your customers.

You can pay on-line using almost any credit card through the Kagi Shareware Registration Service at: http://order.kagi.com/?QMX

Or you can use the Order application (not available on Unix) to create an order which you can send via e-mail, fax or mail to Kagi together with a check or cash (please consult Reame.pdf for more information). In Europe you can also fill out and print the form Order.pdf and send a check or money order to PrePress-Consulting, Bottmingerstrasse 92, CH-4102 Binningen, Switzerland. Our postal account in Switzerland is PC 40-49772-1. Paying us in Switzerland however can take 2 to 3 weeks. The fastest way to get your registration key is to deal with Kagi.

When we have received your shareware fee we will send you instructions to install the registration key. When this key is loaded, the limitations of the demo version will be deactivated. Therefore, do not forget to tell us your correct e-mail address. This will be the fastest way to send you the instructions.

If we get enough feedback (in the form of checks!) we will create a new series of tools (we already have a lot of interesting ideas).

Thank you very much for your support!


MORE INFORMATION

For additional information please contact sjaeggi@prepress.ch or info@lupinsw.com.
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 an  soft keys 7

       soft key 7
              soft keys 7
2-line Y cor  1

#

AA Ni-CD rechargeable batter-
ies 1

ACCEPT soft key 7
accessing

both lines 27, 28
Call Lo  47, 51
Directory 45
external line x, 21, 22
intercom line ix, 19
internal line ix, 19
Redial list 23

acknowledge tone 11
adding

cordless handsets and 
Desk Stations xiv, 30, 
61

local area codes 48
adjusting

cordless handset settings 
8, 12, 28

cordless handset volume 
11

date and time 12
DTMF tone short/long 29
Fax/Modem Alerting 

setting 26
flash signal length 28
language 13
line select time 28, 29
pitch 10, 11
ringer settings 10, 11
Room Monitor’s trigger 

level 8
Set Search setting 30
tone/pulse dialing 29

which line to dial out on 21, 
27, 28

ALL INT soft key 7, 20
Already Registered message 3
alternate long distance carriers 

29
announced transfer xii, 34

from cordless handset 36
from Desk Station 34

announcements on Answering 
System 56

answering calls
by pressing the TALK key 

22
from cordless handset 24
from Desk Station 24
when both lines rin  25
while on another line 32, 

33
Answering System 53

at Desk Statio  53
Caller ID information 54
display 53
gaining remote access 

from cordless handset 
58

gaining remote access 
from touch tone phone 
58

listening to messages 54
managing 

announcements 55, 56
managing settings 55, 57
recording a call 57
remote access cards 87
shortcuts from Desk 

Station 54
types of announcements 

56
area codes 48
�
��( "<



assigning names to cordless 
handsets and Desk Sta-
tions 13

attaching
belt clip 4
headset 3

Auto Backlight 12
Auto Call Accept 24
Auto Line Select 28

1

barring outgoing calls 28
batteries

charging 4
compartment cover 1
inserting vii
spare 4
specifications 67
standby time 5
type used 1
warning 11
warnings and safety 

precautions xvii
belt clip 1
buying

more handsets and desk 
stations lxxvii, lxxix

�

Call Barring effect on 911 calls 
28

Call Lo
accessing 47, 51
adding local area codes 48
defining local area codes 

48
deleting Directory entry 

from cordless handset 
52

deleting Directory entry 
from Desk Station 48

deleting entire log from 
cordless handset 52

deleting entire log from 
Desk Station 48

effects of Caller ID on 50

listening to messages from 
Desk Station 48

number of entries 47
opening from cordless 

handset 51
opening from Desk Statio  

47
returning a call from Desk 

Station 48
returning call from 

cordless handset 52
saving to Directory from 

cordless handset 52
saving to Directory from 

Desk Station 48
call screening with Answering 

System 57
Call Waiting 5, 28, 33
Caller ID 5, 33, 49

effects on display 47, 49
mixed case display 50
on Call Waiting 49

CALLERS key 47
calling 911

effects of Call Barring on 
28

not possible whe
keyboard is protecte  8

when handset is locked 8
calls pending 31
changing the PIN

cordless handset 10
for Desk Station 9

Charger
components 4
illustration 1
installation 4
specifications 67

checking Directory memory 42
coiled cor  1
components

Charger 4
cordless handset 3
Desk Station 2

CONF key 6
4B



Conference callin
creating xiii, 37
ending 37
rules for 37

configuring your lines 28
contents of the system box 1
controllin

what you hear 10
what you see 12

copying
Call Log entries to 

Directory from Desk 
Station 48

Directory entry to another 
handset 46

Directory to another 
handset 46

Redial numbers to the 
Directory 23

cordless handset 1
assigning names 13
changing the PIN 10
components 3
deregistering 17
display messages 3
forgetting the PIN 62
hard keys 6
illustration 1
limiting access 28
local settings 11
locking and unlocking 8
operational range 5
registering 14
ringer settings 10
setting up 3
soft keys 7
specifications 68
volume 10, 11

creating
Conference call xiii, 37
cordless handset Directory 

entry 44
Desk Station Directory 

entry 45
customer support xvi, 61

	

date and tim  12
DEL soft key 7
deleting

Call Bar number 27, 28
Call Log entry from Desk 

Station 48
Call Log from cordless 

handset 52
Directory entry from 

cordless handset 52
Directory from cordless 

handset 44
entire Call Log from Desk 

Station 48
Redial number 23

deregistering cordless hand-
sets 17

Desk Station
assigning names 13
changing the PIN 9
components 2
forgetting PIN 62
hard keys 5
illustration of 1
listening to messages 55
ringer settings 10
setting up 2
specifications 67
volume 10

dialin  29
* key 20
automatically for local area 

codes 48
automatically with long 

distance carrier’s 
dialing cod  29

before a dial tone 22
DTMF short/long 29
external numbers 22
external numbers from 

cordless handset 22
external numbers from 

Desk Station 21
from cordless handset 
�
��( 4�



Directory 43
from Desk Statio

Directory 42
from Redial list 23
inserting a pause 46
internal calls from cordless 

handset 20
internal calls from Desk 

Station 19
short/long DTMF 29
tone/pulse 29
with call on hold 32
with Mail keys 22
with SpeedDial 22

DIRCTRY soft key 7, 43
Directory

accessing 41, 45
capacity 41
checking memory from 

cordless handset 44
checking memory from 

Desk Station 42
copying to another Desk 

Station or handset 46
creating an entry 45
deleting an entry from 

cordless handset 44
deleting an entry from 

Desk Station 42
deleting entire Directory 

from cordless handset 
44

deleting entire Directory 
from Desk Station 42

dialing from cordless 
handset 43

dialing from Desk Station 
42

editing an entry 45
searching for entries 46
sending entire Directory 

from cordless handset 
44

text entry 45
display messages

Already Registered 3
Please Register 3
Searching for Base 3

Distinctive Ringing 5, 26
DSK soft key 7

!

emergency calls
barring 28
effects of Call Barring o  8
not possible whe

keyboard is protected 
(locked  8

enabling and disabling
acknowledge tone 11
Auto Backlight 12
Auto Line Select 27, 28
battery warning 11
Call Barring 27, 28
Caller ID display 27
error tone 11
hold ton  38, 39
key click sounds 11
keyboar  8
Privacy setting 27, 38, 39
range warning 11
ringer 10
Room Monitor 9
speakerphone/mute 20
sync ton  11, 12

END key 6
ending

active calls from cordless 
handset 6, 25

active calls from Desk 
Station 25

conference calls 37
held calls from cordless 

handset 25
held calls from Desk 

Station 25
menus 6

English language 13
entering phone numbers into

Call Barring list 27
4�



Directory 45
Directory from Call Lo  48

error tone 11
exiting menus 6
external calls

announced transfer from 
cordless handset 36

announced transfer from 
Desk Station 34

answering from cordless 
handset 24

answering from Desk 
Station 24

answering while on 
another line 32

creating a conference 37
ending 25
ending a conference 37
ending from cordless 

handset 25
ending from Desk Station 

25
making from cordless 

handset 22
making from Desk Station 

21
making from Redial list 23
making with SpeedDial 

and mail keys 22
placing on hold from 

cordless handset 32
placing on hold from Desk 

Station 31
regular (fast) transfer from 

cordless handset 35
regular (fast) transfer from 

Desk Station 34

�

factory defaults
original settings 17
resetting cordless handset 

to 18
resetting Desk Station to 

17

fast (regular) transfer
from cordless handset 35
from Desk Station 34

fax 26
Fax/Modem Alerting setting 26
feedback tones 11
finding a Directory entry 46
flash short/long 28
foreign languag  13
French language 13

>

GET L# soft key 7
getting hel  xvi, 61

�

headset jack 3
hearing aid wearers xx
held call 32
help and customer support xvi, 

61
HOLD soft key 7
hold ton  38, 39

"

illuminating the display 12
incoming calls 2
inserting a pause

in Directory entry 43, 46
when dialing 22
when using Call Barring 27

installing the Gigaset 2420 2
INT # soft key 7
INT key 6
internal calls

announced transfer to 
external party from 
cordless handset 36

answering from cordless 
handset 24

answering from Desk 
Station 24

creating a conference 37
ending 25
ending a conferenc  37
ending from cordless 

handset 25
�
��( 4)



ending from Desk Station 
25

making from the cordless 
handset 20

making from the Desk 
Station 19

placing on hold from 
cordless handset 32

placing on hold from Desk 
Station 31

regular transfer to external 
party from cordless 
handset 35

tranferring to external 
party from Desk Station 
34

:

JOIN L# soft key 7
joining ongoing calls 38

�

key clicks 11
keyboard 8
keys

cordless handset hard 
keys 6

cordless handset soft keys 
7

Desk Station hard keys 5

�

labels for SpeedDial 87
language

English 13
French 13
Spanish 13

limiting handset access
to lines 28
to numbers 28

LINE 1, L1 soft key 7
LINE 2, L2 soft key 7
line access 8, 27, 28

setting for cordless 
handsets 28

setting for Desk Stations 
28

Line Configuration menu 27, 
28

Line keys 21
line select 27, 28
listening to messages 54, 55
Local Settings men  11
locking

the cordless handset 8
the keyboard 8

logging calls 52
long distance carriers 29
long distance prefix 27
long/short dial delay 29
long/short flash 28
long/short seizure 29

�

MAIL key 54
making calls 2

externally from cordless 
handset 22

externally from Desk 
Station 21

internally from cordless 
handset 20

internally from Desk 
Station 19

manually selecting a line 28
maximum message length on 

Answering System 57
maximum number of

active cordless handsets 5
calls at one time 5
cordless handsets per 

Desk Station 5
digits in a Directory 

telephone number 46
Directory entries 41

memory 42
MENU key 6
menus

Base settings 13
Call Log 48, 52
cordless handset mobile 

settings 12
4,



cordless handset system 
settings 13

Desk Station settings 11, 
12

Directory 42, 43
exiting 6
Mobile settings 10, 14, 18
Room Monitor 9
System settings 9, 13, 14, 

17
Telephone Lock 9

mixed case display with Caller 
ID 50

modem 26
monitoring a room 8, 9
MSGs key 53
mute a call 20

2

naming
cordless handsets 13
Desk Stations 13

number of rings
Answering System 57

$

OK soft key 7
opening

Call Log from cordless 
handset 51

Call Log from Desk Station 
47

outgoing calls 2

�

pausin
after seizing a line 29
in Directory entry 43, 46
when entering numbers 22
when using Call Barrin  27

PIN
changing cordless 

handset 10
changing Desk Station  9
forgetting 62

pitch 10
adjusting ringer 11

placing calls on hold
from cordless handset 32
from Desk Station 31

Please Register messag  3, 
15

power outag  xxi
power supply 1
preferring a lin  28
preventing

accidental key presses 8
handsets from joining 

active and held calls 38
Privacy setting 38, 39
product specifications 67
pulse/tone dialing 29
PWR key 6

?

quick start instructions vii




range of cordless handset 5
range warning 11
RECALL soft key 7
recalling a held call 32
recording a phone call 57
recording system settings 

changes 79
Redial list 23
Redial soft key 7
registering

with two Desk Stations 30
registering cordless handsets 

14
REGISTR soft key 7
regular (fast) transfer

from cordless handset 35
from Desk Station 34

remote access
gaining to Answering 

System 58
listening to messages 59
managing 

announcements 59
managing settings 59
shortcuts for listening to 
�
��( 4*



messages 60
remote access cards for An-

swering System 87
resetting a PIN

for cordless handset 10
for Desk Stations 9

resetting to factory defaults
cordless handset 18
Desk Station 17

restricting
access to cordless 

handset 8
line access 28
outgoing calls 28

retrieving other person’s held 
call 38

returning a call from
Call Lo  52
Redial list 23

ringer
pitch 10
volume 10

RINGOFF soft key 7
Room Monitor 8
rubber stops 1

�

safety instructions and product 
information xv

Searching for Base message 
3, 15

searching for Directory entries 
46

selecting a language 13
selecting lines

automatically 28
manually 28
menu settings 27

Set Search setting 30
short/long dial delay 29
short/long flash 28
short/long seizure 29
Siemens help line numbers 61
soft keys 7
Spanish language 13

Speaker/Mute key 20
specifications

Charger 67
cordless handset 68
Desk Station 67

SpeedDial keys
entering, editing, or 

deleting numbers 22
SpeedDial labels 79
standby time 5
subscribing to telephone com-

pany services 5
switching between speaker-

phone and corded handset 
20

sync ton  11, 12
synchronizing

sync ton  12

�

TALK key 6
talk time 5
TDD access 61, lxxix
technical support xvi, 61, lxxix
telephone line cord 1
telephone lock 8, 9
text entry 45

erasing characters 45
inserting characters 45
inserting spaces 45
key press table 45

time and dat  12
TOGGLE soft key 7
toggling

between an active call and 
one on hold 32

while using Call Waiting 33
toll-free Siemens number lxxix
tone/pulse dialing 29
tones 11
transferring calls

announced transfer from 
cordless handset 36

announced transfer from 
Desk Station 34
4"



external 34
internal 34
on hold 34
regular (fast) transfer from 

cordless handset 35
regular (fast) transfer from 

Desk Station 34
TRANSFR soft key 7
troubleshooting 61

�

unlocking
the cordless handset 8
the keyboar  8

using
alternate long distance 

carriers 29
fax or modem 26
menus 6

�

Visual Mail Waiting Indicator 5
voice call 20
voice mail 54
volume

cordless handset 10
Desk Station 10
ringer 10, 11

/

warnings xv, xviii
warranty information xxi
�
��( 44
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	System User Manual for the Gigaset 2420
	List of Tables
	Quick Start
	Installation
	Getting Your System Up and Running
	1. Install the desk station and insert batteries in the handset(s). See page 2.
	2. Let the handsets charge for eight hours.
	3. Register additional handsets. See pages xiv and 14. (Handsets shipped with the desk station ar...
	4. Place the handsets wherever you like. They do not need direct phone jack connection.



	How to See
	Calling Another Handset
	Calling External Numbers
	Fast, regular Transfer
	Announced Transfer
	Creating a conference call
	Registering a Handset
	Important Safety Instructions and Product Information
	1. Read and understand all instructions.
	2. Follow all warnings and instructions including those marked on the product.
	3. Unplug this product from the wall telephone jack and power outlet before cleaning. Do not use ...
	4. Do not install the desk station in the bathroom or near a wash bowl, kitchen sink, or laundry ...
	5. Do not place this product on an unstable cart, stand, or table. The product may fall, causing ...
	6. Slots or openings in the cabinet back and bottom of the desk station, charger, and handsets ar...
	7. This product should be operated only from the type of power source indicated on the marking la...
	8. Do not overload wall outlets and extension cords as this can result in fire or electrical shock.
	9. Never push objects of any kind into this product through cabinet slots as they may touch dange...
	10. To reduce the risk of electrical shock or burns, do not disassemble this product. Opening or ...
	11. Unplug the desk station from the wall outlet and refer servicing to qualified service personn...
	a. If liquid has been spilled into the product.
	b. If the product has been exposed to rain or water.
	c. If the product does not operate normally when following the operating instructions in this man...
	d. If the product has been dropped or cabinet has been damaged.
	e. If the product exhibits a distinct change in performance.
	12. Avoid using telephone during an electrical storm. There may be a risk of electrical shock fro...
	13. Do not use the telephone to report a gas leak in the vicinity of the leak.
	14. The antenna on the desk station does not retract. To prevent injury, do not place the telepho...
	15. Do not place metal objects on the antenna.
	16. Do not install the desk station or charger near microwave ovens, radio equipment, or non-grou...
	17. The desk station must be placed on a hard, flat surface and connected to both a phone wall ja...
	18. The charger must be placed on a hard, flat surface and connected to a functional 110 volt AC ...
	19. This telephone will not operate in the event of a blackout. Please keep a backup phone for em...
	Battery Precautions
	1. Only use type AA rechargeable Nickel-Cadmium (Ni-Cd) or type AA Nickel-Metal Hydride (NiMH) re...
	2. Always follow basic safety precautions when using and disposing of batteries. Do not dispose o...
	3. DO NOT USE ALKALINE OR LITHIUM BATTERIES IN THE HANDSET BATTERY CHARGER OR RESERVE BATTERY COM...
	4. Periodically clean the charge contacts on both the charger and handset.
	5. DO NOT mix old and new batteries in this product.
	6. Position positive (+) battery contact to match diagram in handset and spare battery compartment.
	7. Charge the batteries provided with, or identified for use with, this product only in accordanc...
	8. Exercise care in handling batteries in order not to short the batteries with conducting materi...
	9. Do not open or mutilate the batteries. Released electrolyte is corrosive and may cause damage ...
	10. Only use the same rechargeable battery type. DO NOT combine Ni-Cd and NiMH rechargeable batte...
	11. During charging, batteries heat up. This is normal and is not dangerous.
	12. Do not use non-Siemens charging devices. This could damage the batteries.
	13. The RBRC™ Battery Recycling Seal on the nickel-cadmium (Ni-Cd) batteries contained in the bat...
	1. Increase the separation between the base station and receiver.
	2. Connect the base station into an outlet on a circuit different from that to which the receiver...
	3. Consult the dealer or an experienced radio TV technician for help.

	Limited Warranty


	Installation
	Contents of System Box
	Instructions

	Installing the Desk Station
	Setting Up a Cordless Handset
	Setting Up a Charger Cradle
	Charging Extra Batteries
	The Basics

	Desk Station Keys
	Cordless Handset Keys
	Using Menus
	Table 1: Cordless Handset Soft Keys Defined

	Protecting the Handset
	Disabling the Keyboard
	Locking and Unlocking a Cordless Handset

	Room Monitor
	Table 2: Locking a Handset or Using it as a Room Monitor

	Changing a Pin
	1. Press the desk station’s MENU key. Scroll to “System Settings” and press SELECT. Enter the cur...
	2. Scroll to "Change System PIN?" and press SELECT.
	3. Enter the new PIN and press SELECT. The PIN must be 4 digits and cannot contain * or #. Confir...
	1. Press the cordless handset’s MENU key. Scroll to “Mobile Settings” and press OK.
	2. Scroll to “Local Settings” and press OK. Scroll to “Change PIN” and press OK.
	3. Enter the handset's PIN (default is 0000). Press OK. Enter the new PIN, press OK. The PIN can ...

	Controlling What You Hear
	Changing Desk Station Volume and Pitch
	Table 3: Choosing a Cordless Handset’s Volume, Pitch, and Tones

	Desk Station Feedback Tones
	Table 4: Feedback Tones


	Controlling What You See
	Date and Time
	Table 5: Choosing the Desk Station Display Contrast and Setting Date and Time

	Cordless Handset’s Auto Backlight
	Assigning Names to Cordless Handsets and Desk Stations
	1. Press MENU. Scroll to "System Settings" and press SELECT. Enter System PIN and press SELECT.
	2. Scroll to “Assign Name” and press SELECT.
	3. Scroll to the desired handset or desk station and press SELECT. See page 45 for information ab...
	4. Press SELECT to save entry.
	1. Press the cordless handset’s MENU key. Scroll to “Base Settings” and press OK.
	2. Highlight “Base Station 1” or “Base Station 2” and press OK.
	3. Highlight “Change Name” and press OK.
	4. Enter, edit, or clear the name. See page 45 for information about text entry. Press OK when fi...
	5. Highlight “Save Entry” and press OK.

	Choosing a Language
	1. Press the desk station’s MENU key. Scroll to "System Settings" and press SELECT. Enter the sys...
	2. Scroll to "English," "Español," or "Français" and press SELECT.
	1. To assign a language to one cordless handset, press the handset’s MENU key. Scroll to “Mobile ...
	2. Scroll to “Local Settings” and press OK. Scroll to “Language” and press OK.
	3. Scroll to “English,” "Español," or "Français" and press OK.


	Cordless Handset Registration
	1. Press MENU. Scroll to "System Settings" and press SELECT.
	2. Enter system PIN (default is 0000) and press SELECT.
	3. "Mobile Registration" will display. Press SELECT.
	4. Press the PWR key. If the display goes blank at any point during this process, the battery doe...
	5. Enter the system PIN (0000 is the default) and press OK.
	6. It may take a short while for the handset to find the desk station. Once it does, select the i...

	Cordless Handset Deregistration
	1. On the desk station, press MENU. Scroll to "System Settings" and press SELECT. Enter the syste...
	2. Scroll to "Mobile Deregistration" and press SELECT.
	3. Scroll to the desired cordless handset (intercom number).
	4. Press SELECT to deregister the cordless handset.
	1. Press the cordless handset’s MENU key, highlight “Base Settings” and press OK.
	2. Highlight the desired desk station and press OK.
	3. Highlight “Deregister” and press OK. A confirmation tone assures you that deregistration is co...

	Resetting to Factory Default
	1. Press the desk station’s MENU key. Scroll to “System Settings” and press SELECT.
	2. Enter the system PIN and press SELECT.
	3. Scroll to “Factory Defaults” and press SELECT.
	4. When asked to confirm, press SELECT.
	1. Press MENU. Scroll to “Mobile Settings.” Select “Local Settings.”
	2. Highlight “Factory Default” and press OK.
	3. Enter the handset's PIN.
	4. To continue, press OK.
	Making, Answering, and Ending Calls
	Making Internal Calls at The Desk Station
	1. Press the INTCOM key, then pick up handset. Calling on speakerphone or headset: Press the INTC...
	2. Enter the handset’s number or page all handsets by pressing the * key.
	Table 6: Understanding the Speaker/Mute Key
	Table 7: Switching Between Speakerphone and Corded Handset During a Call

	Making Internal Calls on a Cordless Handset
	1. Press the INT key.
	2. Enter the handset’s number or page the desk station and other handsets by pressing * or ALL or...

	Making External Calls at the Desk Station
	Table 8: Understanding the Line Keys

	Making External Calls on a Cordless Handset
	1. Press TALK.

	Entering Numbers Before a Dial Tone

	Desk Station
	1. Enter external number.
	2. Dial by lifting the corded handset or pressing the SPEAKER/MUTE or an unlit line key.

	Cordless Handset
	1. Enter external number.
	2. Dial by pressing the TALK key.
	Dialing with SpeedDial and Mail Keys
	1. Press MENU. Scroll to " Desk Station Settings” and press SELECT. Scroll to “SpeedDial Key" and...
	2. Press a SpeedDial key or the MAIL key.
	3. Scroll to "Store SpeedDial Key" or “Delete SpeedDial Key” and press SELECT.
	4. Enter an external number or press INTCOM then the cordless handset's number. Press INTCOM and ...

	Dialing from the Redial List
	Table 9: Using the REDIAL List

	Answering Calls at the Desk Station
	Answering Calls on a Cordless Handset

	Auto Call Accept
	When Both Lines Ring
	Desk Station
	Cordless Handset
	Ending Calls


	Desk Station
	Table 10: Ending Calls from Desk Station
	1. Press the flashing line or INTCOM key.
	2. Press the REL key or hang up the handset.


	Cordless Handset
	Table 11: Ending Calls from Cordless Handset
	1. Press RECALL.
	2. Press END or put handset in charger.

	Using a Fax or Modem
	1. To direct incoming calls to your fax or modem, press the desk station’s MENU key.
	2. Scroll to “System Settings” using BACK or FWD. Enter the System PIN (0000 is default) and pres...
	3. Scroll to “FAX/Modem Alerting?” and press SELECT.
	4. Choose one of the following and press SELECT.

	Customizing the System
	Table 12: Dialing and Line Options
	Table 13: Barring Calls to Outside Numbers


	Using Automatic Line Select
	Controlling Line Access
	Making Technical Adjustments
	Short/Long Flash
	Short/Long Dial Delay
	Tone/Pulse Dialing
	Short/Long DTMF

	Using Alternate Long Distance Carriers
	If You Have Two Desk Stations
	1. Press MENU. Scroll to “Base Settings” and press OK.
	2. Scroll to “Set Search” and press OK.
	3. Choose a setting and press OK.

	Managing Calls
	Using Hold at the Desk Station
	Using Hold on a Cordless Handset
	Answering an Incoming Call while on Another Line


	Call Waiting
	Transferring Calls

	Transferring at the Desk Station
	Transferring from a Cordless Handset
	Fast, Regular Transfer
	Announced Transfer
	Conference Calls


	Creating a Conference
	Table 14: Ending a Conference
	Customizing the System

	Hold Tone and Privacy Setting
	Table 15: Privacy and the Hold Tone
	Directory and Call Log
	Directory
	Opening the Desk Station Directory
	Table 16: Desk Station Directory
	1. Enter handset number.
	2. Receiver answers and enters handset PIN. (Originally 0000)
	3. Entry sent.
	1. Press handset number.
	2. Receiver answers and enters handset PIN. (Originally 0000)
	3. Directory sent.


	Opening a Cordless Handset’s Directory
	Table 17: Managing Entries in a Cordless Handset Directory
	1. Enter handset or desk station number and press OK.
	2. Receiver answers and enters handset or system PIN. (Originally 0000)
	3. Entry sent.
	4. Scroll to next desired entry and press SEND or press END.

	Table 18: Managing a Cordless Handset Directory
	1. Enter handset or desk station number and press OK.
	2. Receiver answers and enters handset or system PIN. (Originally 0000)
	3. Entry sent.


	Creating or Editing Entries




	Entering Names
	Key Presses
	Telephone Numbers
	Copying Entries or Entire Directories to Other Phones
	Searching for Entries
	Call Log
	Opening the Call Log at the Desk Station
	Table 19: Understanding the CALLERS Key
	Table 20: Using Call Log at the Desk Station

	Setting up Area Codes in Call Log
	1. From the Systems Setup menu, scroll to "Area Codes" on your screen and press SELECT.
	2. Local Area Code - If you are in a city with one area code, specify your local area code. Local...
	3. Extra Area Code 1, 2, or 3 - If you are in a city with more than one area code but local calli...
	4. Scroll to the desired choice, press SELECT, enter the area code, and press SELECT again.

	Effect of Caller ID on Call Log


	Changing the Caller ID Display
	1. Press MENU. Scroll to "System Settings" and press SELECT. Enter System PIN and press SELECT.
	2. Scroll to “Caller ID Display” and press SELECT.
	3. Toggle with the SELECT key. Preserve the setting by exiting the menu.
	Opening the Call Log on a Cordless Handset
	Table 21: Using Call Log on a Cordless Handset

	Determining Which Calls to Log
	1. Press MENU. Scroll to "System Settings" and press SELECT. Enter System PIN and press SELECT.
	2. Scroll to “Call Log” and press SELECT. Highlight either “Log All Calls,” “Log Unanswered,” or ...

	Answering System
	At the Desk Station
	Table 22: Understanding the MSGs Key


	Listening to Messages By Pressing MSGs and MAIL Key
	Table 23: Desk Station Message Shortcuts
	Table 24: Desk Station: Listening to Messages and Managing Announcements and Settings

	Announcements
	1. Press MENU.
	2. Scroll to “Answering System” and press SELECT.
	3. Scroll to “Announcement” and press SELECT.
	Kinds of Announcements

	Answering System Settings
	Recording a Phone Call
	1. While on an active call, press the MENU key.
	2. The first display says “Record Call?” Press SELECT.
	3. Press the BACK key to restart recording. Stop recording by pressing the SELECT key or by hangi...

	Remote Access

	Getting Remote Access with a Touch Tone Phone
	Getting Remote Access with a Cordless Handset
	Table 25: Remote Access: Listening to Messages and Managing Announcements and Settings
	Table 26: Remote Access Message Shortcuts
	Troubleshooting

	If you are using one line:
	The cordless handset’s display flashes the message “Searching” or “Please Register.”
	The cordless handset is dead. The display is blank. No buttons operate.
	The PIN is not 0000.
	Cannot dial from the call log.
	Conversation on the cordless handset is interrupted frequently or you cannot make a call.
	The desk station is dead.
	Caller ID information does not appear on the display.
	There is dial tone on only one of my two telephone lines. Calls are being received on only one line.
	The phone does not ring, but the status lights and/ or display behave as if there is an incoming ...
	Certain telephone numbers cannot be dialed.
	Display messages are in a foreign language.
	Cannot make outgoing calls even though incoming calls can still be received.
	The MAIL key on my desk station does not light up when I get telephone company messages.
	My fax does not pick up calls.
	System disconnects second call when you try to answer it.
	Your calls are connected to erroneous destinations.
	Product Specifications
	Desk Station
	Charger
	Handset

	Index
	System Settings Changes
	SpeedDial Labels
	Remote Access Cards for Answering System
	1. Dial phone number:___________________________
	2. When the answering system answers, press * *
	3. When prompted, enter your system PIN:________
	4. To play new messages, press 6. To play all messages, press 5.
	5. While listening to messages: To delete message, press 6. To repeat message, press 1. To skip t...
	1. Dial desk station phone number:_______________
	2. When the answering system answers, press * *
	3. When prompted, enter your system PIN:________
	4. To play new messages, press 6. To play all messages, press 5.
	5. While listening to messages: To delete message and skip to next one, press 6. To repeat messag...
	1. Dial desk station phone number:_______________
	2. When the answering system answers, press * *
	3. When prompted, enter your system PIN:________
	4. To play new messages, press 6. To play all messages, press 5.
	5. While listening to messages: To delete message and skip to next one, press 6. To repeat messag...




